
What´s new

© SOFTTECH AG

© Tiberius Gracchus / Fotolia



 

Copyright, Legal Notice 
All Rights reserved. No part of this document may be reproduced in any form (print, photocopy or 

any other process) without the written permission of STI International, Inc. or processed using 

electronic systems, duplicated or distributed.  

All technical details in this document were developed by STI International, Inc. with the greatest care 

and compiled and reproduced using effective control measures. Errors nevertheless cannot be 

completely ruled out. STI International, Inc. is therefore obliged to inform you that it assumes no 

guarantee, legal responsibility or liability for any consequences arising due to erroneous information. 

STI International, Inc. is always thankful and grateful for informing us of any errors. 

SPIRIT, GRAVA and AVANTI are registered trademarks of SOFTTECH AG. All other brand and product 

names are Trademarks or Registered Trademarks of other companies. 

Windows® is a Registered Trademark of Microsoft Corporation© 

Photo credits: SOFTTECH AG, unless otherwise specified. 

 

 

 

 

 

 

 

 

STI International, Inc. 

114 Franklin Street 

Concord, NH 03301 

 

Telephone +1(603) 369 3019 

Fax +1(206) 274-7256 

E-Mail info@softtech.de 

www.softtech.de/en

 

Document-Nr.: SWN-CAD-2021, Effective: 11/23/2021 

  

mailto:info@softtech.de


SPIRIT 2021 – What´s new 

2 

 

Table of Contents 
Adaptations – SPIRIT 64-bit Version ........................................................................................................................................... 3 

Adaptations – Drawing status .................................................................................................................................................... 4 

Adaptations – Improved drawing control .................................................................................................................................. 5 

Adaptations – Support dialogues ............................................................................................................................................... 6 

Adaptations – Program title bar and list of open windows ........................................................................................................ 7 

Adaptations – Object inspector element count ......................................................................................................................... 8 

Adaptations – Architectural variables for rooms ....................................................................................................................... 9 

Adaptations – New variable for effective scope....................................................................................................................... 10 

Adaptations – Zip and Go ......................................................................................................................................................... 11 

Adaptations – Import PDF file as a vector with no text or with better images ........................................................................ 14 

Adaptations – Polygon ............................................................................................................................................................. 16 

Adaptations – Loading references ............................................................................................................................................ 17 

Adaptations – Visibility of references ....................................................................................................................................... 18 

Interface – SketchUp 2021 ....................................................................................................................................................... 19 

Interface – Export ac2018 (ac1032) ......................................................................................................................................... 20 

Cut – New Options dialog ......................................................................................................................................................... 21 

Cut – Save cutting options ........................................................................................................................................................ 22 

Cut – Level of detail .................................................................................................................................................................. 23 

Cut – Views with fill and outline ............................................................................................................................................... 24 

Cut – Color of the cutting line .................................................................................................................................................. 25 

Multi-View – For more harmony between preview and plan .................................................................................................. 26 

Output – Definition of the file name for file output ................................................................................................................. 28 

Output – Call up printer settings .............................................................................................................................................. 29 

Functions – Align objects .......................................................................................................................................................... 30 

Functions – Arrange objects ..................................................................................................................................................... 31 

Functions – Align hatching ....................................................................................................................................................... 33 

Functions – Deactivate magnet cursor for short time .............................................................................................................. 34 

Functions – The smallest dimension becomes the thickness of the polyslab .......................................................................... 35 

 

Note 

The following pages describe the new features of the current version. All new features apply 

exclusively to SPIRIT, provided the corresponding licensed program sections are available on the 

user’s/customer’s computer. 

 For more information, please refer to the online help. The new features are listed on the start 

page and are linked to the respective chapter, where the feature is explained in detail. 
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Adaptations – SPIRIT 64-bit Version 

Support 64-bit operating systems. 
Description 

With version 2021, SPIRIT is available for the first time as a 64-bit program for your 64-bit Windows 

operating system. 

Up to version 2020, SPIRIT was a 32-bit system and could only use ~ 3.5 GB of RAM or memory, 

regardless of how much your hardware provided. So even if you have 16 GB of RAM, SPIRIT 2020 

could only access 3.5 GB and the rest went unused. 

SPIRIT 2021 can now effectively access more memory, which has a positive effect on many work 

areas. Here some examples. 

Export DWG / DXF 

Exporting drawings with many 3D solids is now much faster with SPIRIT 2021. 

Import references 

The importing and loading of references or drawings with references is now much faster thanks to 

the changeover to the 64-bit version. 

Loading image files 

Due to the larger memory addressing, drawings with many images can be loaded and edited more 

efficiently. 

Pan and zoom 

Moving the drawing area with functions such as panning and zooming also benefits from the greater 

memory addressing. 

Open the S12 

In principle, larger S12 files can be opened faster with SPIRIT 2021. 

Value 

 Optimization of the use of hardware resources in a 64-bit system. 

 64 bit as the basis for future performance optimizations in SPIRIT. 
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Adaptations – Drawing status 

Recommendations for reorganizing drawings. 

Description 

With SPIRIT 2021, constant control of the drawing was implemented by the drawing status. This 

status indicates whether the drawing is OK or whether it contains problematic elements. Clicking on 

the status gives you quick access to the dialog with the Purge drawing function and can use it to put 

the drawing back in order if necessary. 

Function 

The constant drawing control in SPIRIT 2021 was implemented via a corresponding toolbar. Ideally, 

this should always show the status "OK": 

  

If the drawing control encounters possible problems in the drawing, the status changes to "Notes" or 

"Error": 

 

The menu for reorganizing the drawing can now be called up directly with a click on the status bar. 

Alternatively, you can contact support immediately to determine the cause. 

Value 

 Early recognition of possible problems. 

 Direct reorganization via the toolbar. 

 Optimized handling of S12 drawings.  
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Adaptations – Improved drawing control 

More information with CTRL + J and drawing check. 

Description 

With the drawing check, SPIRIT 2021 now has a constant eye on your drawing. With the improved 

drawing control, which you can also carry out at any time with the shortcut key [CTRL] + [J], no 

unintentional interlinking problems should arise in the S12 drawing. 

The early warning system for your drawings is therefore optimally active and offers you safe handling 

of old and new SPIRIT drawings. 

Value 

 Early recognition of possible problems. 

 Optimized handling of old and new S12 drawings.  
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Adaptations – Support dialogues 

Security and trust as the basis 

Description 

Version 2021 is not only the first SPIRIT as a 64-bit version, but also offers other minor changes that 

make SPIRIT 2021 a stable and high-performance CAD-BIM system. 

By integrating an error reporting system, SPIRIT 2021 better documents internal errors that could 

lead to your system crashing. If SPIRIT should crash in 2021, SPIRIT will document the system content 

that led to the crash. You can forward this directly to your SOFTTECH customer advisor via email. 

A classic win-win situation, because the SOFTTECH development department receives detailed data 

on the program crash and you receive your SPIRIT updates with the corrections faster. 
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Adaptations – Program title bar and list of 

open windows 

Better overview of open drawings. 

Description 

Previously, the program version was always displayed first in the program title bar, followed by the 

file name of the currently active drawing with the entire storage path: 

 

This was changed with SPIRIT 2021 in order to be able to recognize more quickly which drawing is 

currently active on the drawing area. Here the drawing name is displayed first, then the program 

version and only at the end the storage path: 

 

In addition, the display in the list of open drawings in the pull-down menu Window has been 

adjusted. In this list, the entire file name of the currently active drawing was previously displayed 

with the entire storage path. 

In SPIRIT 2021, the file name is displayed first and only then is the storage path: 

 

Value 

 Better overview of the open drawings. 

 Faster change between the open drawings.  
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Adaptations – Object inspector element count 

Total number of selected elements at a glance. 

Description 

When selecting several elements, it is often helpful to be able to read the exact number of the 

selected elements directly. Previously, this was only possible if the pull-down menu at the top was 

opened in the Object Inspector. In addition, a display of the total number was missing so far. 

Function 

The object inspector in SPIRIT 2021 has been revised and now directly shows the total number of 

currently selected elements. 

As soon as several elements are selected via a range selection or with the help of the CTRL key, the 

Object Inspector directly shows the total number of selected elements. 

 

Value 

 Quick overview of the total number of selected elements. 
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Adaptations – Architectural variables for 

rooms 

Variables OK-RFB and OK-FFB for room stamps added. 

Description 

In order to more easily integrate the values for OK-RFB and OK-FFB (upper edge of unfinished floor 

respectively finished floor) into a room stamp for rooms from the architecture system, corresponding 

variables have been added to the list of room stamp contents. 

Function 

The variables OK-RFB and OK-FFB are available in the list of room stamp contents and can be set 

from here in room stamps. 

This room stamp contents can be opened via pulldown menu Architecture > Room Stamp Contents. 

 

Value 

 The values for OK-RFB and OK-FFB can be set in room stamps. 

 When working with a 3D building model, these values are automatically adjusted when changes 

are made to the model.  
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Adaptations – New variable for effective 

scope 

Areas and perimeters are better evaluated. 

Description 

Polylines can be used to create a wide variety of drawing elements. It is often necessary to evaluate 

the values of these elements such as area, circumference and volume and display them in the 

drawing area. In SPIRIT 2021, the list of available variables was expanded to include the variable for 

the effective scope. 

Function 

The variable @Area Property.Effective Values.Amount + Extent of Deductions@ has been added to 

the list of variables and can now be used in object stamps. 

With SPIRIT 2021 it is possible to display all quantities of a polyline in an object stamp: 

circumference, effective circumference, area, effective area, volume, effective volume. 

Value 

 Effective scope available in object stamp. 

 Areas and perimeters can be better evaluated. 

 All quantities of a polyline can be placed as a stamp.  
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Adaptations – Zip and Go 

It is more convenient to pack your drawing into a package 

Description 

The Zip and Go function was completely revised and now offers some new functions. Zip and Go 

creates a compressed archive folder with all files belonging to the drawing. In addition to the actual 

drawing file, all external files referenced in the drawing file are recorded. All files are displayed in a 

list and you are also free to choose whether the files should be recorded or not. 

Function 

When you run Zip and Go you will now be asked whether you want to save the current drawing or 

not. This gives you control over which drawing status ends up in the archive. 

  

You now have two options for creating the zip archive: 

 

As before, the option Keep directory structure records the drawing file and all external files and 

packs them with the original directory structures in a zip folder. 

The option No directory structure also records the drawing file and all external files, but does not 

adopt the directory structure of the external files, but rather places them next to the drawing file in 

the zip folder. In doing so, SPIRIT will inform you if this option results in duplicate names in the file 

and these should first be resolved. 

A name duplication (file duplication) can happen if z. For example, two symbols or components with 

the same name but from different paths can be used in the drawing. 

The duplicate files are also marked in red in the content tree. You can now decide at this point by 

activating or deactivating the check boxes which files should be stored in the ZIP file. 
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At this point, it is also advisable to check the duplicate files to see whether they really make sense in 

the drawing or are due to accidental work steps in the drawing and whether these should not 

generally be eliminated in the drawing. 

In addition to the Preserve directory structure function, you can also use the Archive embedded files 

option. This allows you to output the files embedded in the drawing such as components, images or 

references separately in the zip archive. This option is only available in connection with Keep 

directory structure. 

 

The latest addition to Zip and Go is the Zip report. First of all, you are free to add an additional 

comment to the zip archive. This comment is entered in the comment field provided and included in 

the report. 

 

The report can only be viewed before the zip archive is created. 

    

For better documentation and traceability, the report now starts with the SPIRIT version used and 

the creation date of the zip archive, followed by the comment and the path information for the main 

drawing and files. 

The report is saved as a log file in the zip archive and can be opened using the text editor. 
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Value 

 The current drawing status is archived in the zip folder. 

 Both the original folder structure and direct storage of the files in the zip archive is possible. 

 Better documentation on the contents of the zip file. 

 Notes on duplicate files in the drawing.  
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Adaptations – Import PDF file as a vector with 

no text or with better images 

More influence or really hot - what can it be? 

Description 

In order to import 2D basics for planning into SPIRIT, the PDF format plays the most important role as 

a data basis alongside the DWG / DXF files for most users. SPIRIT offers the possibility of importing 

vector information. This has the advantage that you can catch yourself on the drawing elements. 

Depending on how detailed the plan is, such an import can also slow down the workflow, as the 

SPIRIT magnetic cursor also catches on hatching lines or texts for example. 

In SPIRIT we have optimized the import so that you have more setting options for converting a PDF 

file. When converting to EMF, you have two options for converting, including influencing the texts in 

the PDF file. For the conversion to images, the resolution of the files to be imported can now be set 

and, above all, increased. The imported image files enable much smoother and faster work. 

Function 

When converting the PDF file, the new version gives you three options to choose from. One way of 

converting the PDF into an image file and two ways of converting the PDF into an EMF file with all 

vectors. 
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Settings for PDF files - conversion to image 

Under the tab Advanced settings for the conversion to * .JPG files, you can optimize the image size 

and quality. 

You can select a DPI number between 96 and 600 dpi for the conversion result to the image. The 

standard value was previously set to 96 dpi. 

With the compression quality, you also have an influence on how much the image should be 

compressed. The gradation is between 100 and 25. 

Settings for PDF files - conversion to EMF 

As already described, you can convert the PDF file into a vector reference (* .emf) using two different 

methods. The choices are: 

 Vector reference (* .emf) - import mode 2019 

 Vector reference (* .emf) - import mode 2017 

The import results may differ depending on the procedure. PDF plans that are automatically 

generated from BIM models usually contain many more vectorized individual elements than 

conventional PDF files. It is therefore advisable to check the different procedures here. 

For the variant vector reference (* .emf) - import mode 2019 you will find options for handling the 

text display in the PDF file under the tab Advanced settings. Since texts are not retained as text in the 

converted PDF, these settings are used to reduce the vectors to be converted. 

 Ignore text 
The texts in the PDF file are not converted, which affects the conversion time and * .emf file 
size. 

 Simple representation 
The texts are adopted, but converted to the standard Arial font. This can lead to deviations in 
the display. 

 Detailed representation 
The texts are adopted and converted as best as possible using the existing font. 

Value 

 Significantly higher quality when importing image files into SPIRIT. 

 Greater accuracy when capturing dimensions from image files. 

 More flexible options for converting to vectors. 

 Fluid work. 
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Adaptations – Polygon 

Customer opinion is important to us. The center point and 2D lines are back. 

Description 

In one of the last versions of SPIRIT, the function for creating a rectangle was changed using the 

"Polygon" function: Rectangles were automatically created as polylines. In order to get 2D lines, this 

had to be resolved. 

Based on customer feedback, it became clear that this change has resulted in more work for many 

users. Therefore the function has been revised again. 

Function 

A rectangle is created with 2D lines by default using the Drafting > Polygons > Rectangle function. 

Exploding the polyline is no longer necessary. 

With the new option Polyline, the rectangle can alternatively be created as a polyline. This setting 

remains saved until it is changed again. 

The center point for rectangles can also be generated again. After reworking the function, this is also 

possible for rectangles as polylines 

Value 

 Rectangles can again be created directly with 2D lines. 

 Rectangles can optionally be created as polylines. 

 The center point can be created again. 

 The center point can now also be created as a polyline for a rectangle. 
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Adaptations – Loading references 

Open large drawings faster if necessary 

Description 

Working with references is becoming more and more popular. Depending on the filing and size of the 

references, loading a drawing can take some time. 

In SPIRIT 2021 the options for loading references have been expanded. 

Function 

In the system settings you can choose whether references are to be displayed immediately or 

delayed when a drawing is opened: 

 

If the references are delayed, the drawing opens faster and you can start drawing right away. The 

references are reloaded while you work. 

Value 

 If necessary, drawings with many references can be opened more quickly. 
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Adaptations – Visibility of references 

Hide and show references via the context menu 

Description 

The reference technique can be used to insert simple or extensive drawing content into a drawing. 

Sometimes it can be necessary or helpful to hide these references. To make this quick and easy, the 

context menu for references has been extended. 

Function 

References can currently be made visible and invisible via the object inspector. To do this, the value 

for Visible must be changed to No. If so, the reference is displayed with a placeholder. 

To simplify this, the context menu for references was revised with SPIRIT 2021 and the option 

Reference visible was added. This can be used to control the visibility of the selected reference with 

a simple left mouse click. 

 

Value 

 Quickly adjust the visibility of references with 2 mouse clicks. 
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Interface – SketchUp 2021 

File import SketchUp 2021.1 from Trimble 

Description 

SketchUp 2021 has just switched to version 2021.1 due to a major update. The SketchUp interface 

must be maintained so that you can continue to import the SketchUp files. With SPIRIT 2021 you can 

import all common SketchUp models up to the mentioned latest version 2021.1 without any 

problems. 

Value 

 Current interface for SketchUp 2021.1. 
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Interface – Export ac2018 (ac1032) 

Latest files not only when importing. 

Description 

The DWG / DXF interface must also be constantly updated and adapted. With SPIRIT 2021 you can 

export all common DWG formats. Here is a current overview: 

 AutoCAD Release 18 | Version 2004 | AC 1018 

 AutoCAD Release 19 | Version 2005 | AC 1018 

 AutoCAD Release 20 | Version 2006 | AC 1018 

 AutoCAD Release 21 | Version 2007 | AC 1021 

 AutoCAD Release 22 | Version 2008 | AC 1021 

 AutoCAD Release 23 | Version 2009 | AC 1021 

 AutoCAD Release 24 | Version 2010 | AC 1024 

 AutoCAD Release 25 | Version 2011 | AC 1024 

 AutoCAD Release 26 | Version 2012 | AC 1024 

 AutoCAD Release 27 | Version 2013 | AC 1027 

 AutoCAD Release 28 | Version 2014 | AC 1027 

 AutoCAD Release 29 | Version 2015 | AC 1027 

 AutoCAD Release 30 | Version 2016 | AC 1027 

 AutoCAD Release 31 | Version 2017 | AC 1027 

 

New from version 2021 is the export for the DWG / DXF format ac1032 

 

 AutoCAD Release 32 | Version 2018 | AC 1032 

 AutoCAD Release 33 | Version 2019 | AC 1032 

 AutoCAD Release 34 | Version 2020 | AC 1032 

 AutoCAD Release 35 | Version 2021 | AC 1032 

 AutoCAD Release 36 | Version 2022 | AC 1032 

There are no export options older than AutoCAD 2000 (ac1015). 

Value 

 Current interface for DWG / DXF. 
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Cut – New Options dialog 

Only one dialog for all section and view settings 

Description 

As of version SPIRIT 2021, the section and view options are combined in a central dialog and offer all 

possible options depending on one another. 

Function 

The new dialog contains all the settings 

available for generating the section and 

elevation. In addition, some options from 

the menu overview have also moved into 

the dialog. 

This means that all settings relating to the 

generation of sections and elevations can 

be set in one central location. Due to the 

different interdependencies of the 

individual settings, these are visible in the 

new dialog. 

By switching to the central dialog, some 

customer requests were also 

implemented. These are now detailed on 

the following pages. 

 

 

 

Value 

 Central dialog for adjusting all cutting options. 

 It is no longer necessary to switch between different submenus. 

 Simplified adjustments to the editing options thanks to the reduced editing menu. 
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Cut – Save cutting options  

Section and elevation settings are saved in the drawing 

Description 

The options for cutting are extensive and always have a direct influence on the cutting and view 

results. 

So that these settings do not have to be redefined again and again and that different cutting options 

no longer require constant adjustment, the cutting and view settings are saved directly in the 

drawing with SPIRIT 2021. 

In addition, different section and view options can be saved as a section settings file [* .cts] and 

reloaded at any time. 

Integrating the settings in the drawing ensures that the same cutting result is generated on every 

workstation. With the help of the cts file, different cutting settings and the associated cutting results 

can be conveniently stored and loaded and created at any time. 

Function 

In the newly designed section and view settings dialog, the set parameters can be saved as a cts file 

and reloaded. This is only necessary if different cutting results are to be generated for each cutting 

line. Otherwise, all settings made last are used directly for generating the section and stored 

internally in the drawing. 

 

Value 

 Different cutting settings can be saved and reloaded. 

 The pattern can be updated at any time with the correct settings. 

 The cut settings are also available when the file is passed onmenu. 
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Cut – Level of detail  

Architecture detailing in the new section and elevation settings 

Description 

The menu item S3 Detailing from the menu overview Section / Elevation is now also in the new 

dialog and fully integrated into the section view generation. 

Function 

In the newly designed section and view settings dialog, the set parameters can be saved as a cts file 

and reloaded. This is only necessary if different cutting results are to be generated for each cutting 

line. Otherwise, all settings made last are used directly for generating the section and stored 

internally in the drawing. 

 

Value 

 The level of detail is now set in the central dialog. 

 Simplified setting of the level of detail. 
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Cut – Views with fill and outline  

Nicer views with fill and outline 

Description 

The Section - Elevation function makes it possible to generate a section or a view from the 3D model. 

For this purpose, there were the options to create a section or a view as a contour or as a filling. With 

SPIRIT 2021, a combination of both settings is now conceivable. This allows a view with filling and 

contour to be placed in the drawing area. 

Function 

In the newly designed section and elevation settings dialog, the parameters for the cut edge, section 

fill and view edges can be set in relation to one another. This enables the option already mentioned 

above to create a view with fills and contours. 

 

Value 

 Views can be created with fillings and contours. 

 Option to display the visible surfaces according to material management. 
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Cut – Color of the cutting line  

Correct representation of the cutting line 

Description 

The options for the cutting line are of course also integrated in the new dialog. 

New in SPIRIT 2021 is the ability to define different colors for cutting lines and arrows. 

Function 

 

Value 

 Additional options for designing cutting lines 

 Color for cutting line and arrows can be defined separately. 
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Multi-View – For more harmony between 

preview and plan 

The plan and print layout preview has been completely revised 

Description 

Many SPIRIT users use the plan / print layout preview function in a wide variety of applications, be it 

as a preview for plans and print layouts, as temporary entry points for layer switching and cut-outs 

on the drawing area or as a kind of favorites preview of drawing content. With SPIRIT 2021, the 

functions preview plans / print layout and the dockable dialogs plans and print layout have been 

synchronized and expanded with new functions. 

Function 

 

First of all, all names were checked and standardized. 

The preview window is still called via the pull-down menu View 

> Multi-View. 

New function: Open all assigned. 

All assigned plans and print layouts can be displayed in the 

preview windows at lightning speed. 

 

 

 

Another adjustment is that the preview windows are given the 

names of the assigned plans / print layouts.  

In addition, the category is displayed with an icon and the last 

activated plan is identified. 
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The context menu of the preview window has been 

completely revised due to the consistent 

synchronization of the two functions preview plans / 

print layout and the dockable dialogs plans and print 

layout. Here, too, the terminology is clearer and more 

target-oriented. 

When a new preview is added to an view, several steps 

are automatically performed. The function Add from the 

context menu of the display window calls up the 

function New plan. After the plan name has been defined,  

it is assigned directly to the selected preview window. 

Value 

 List of assigned plans / print layouts with preview. 

 Display of name and category (floor plan, section, parallel projection, print layout). 

 Direct selection via mouse click. 

 Inserting references using drag and drop. 

 Update of the assigned plan / print layout. 

 

  



SPIRIT 2021 – What´s new 

28 

 

Output – Definition of the file name for file 

output  

File name can be composed individually with additional characters 

Description 

The issue of output includes not only printing on paper, but also general output to a file. With SPIRIT 

2021, the available variables have been extended by some options, with the help of which the output 

name can be defined for all file formats depending on the drawing. 

Function 

The new function can be found in the 

SPIRIT options under Drawing Settings > 

Output Settings > File Name when 

Printing to File. 

There you will first see a list of the 

available variables, which you can accept 

with a double click in the input line. The 

variables are made up of dates, system 

information and the general information 

group from the plan definition. 

 

 

You then have the additional option of entering the separators in the input line. So you decide 

individually what the file name looks like at the end. Here is a small example with [_] as a separator: 

@DWGNAME @ _ @ VIEWNAME @ _ @ LAYOUTID @ _ @ LAYOUTAUTHOR @ 

In the preview line, you will see a finished example for your currently open drawing. 

Addition SPIRIT 2021: New variable @LayoutIndexDateYYYYMMDD introduced. 

Value 

 The output name can be composed of a wide variety of variables. 

 The defined output name applies to all file formats. 

 The output name can be composed individually with additional characters.  
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Output – Call up printer settings 

Abbreviation for the system printer settings 

Description 

SPIRIT offers various setting options for printing. These are both system settings and settings for 

individual plans or print layouts. Previously, in order to adjust the system printer settings, the options 

had to be opened and the corresponding submenu called. 

With SPIRIT 2021, the printer system settings can be called up directly from the "Print" menu. 

Function 

The new function System printer settings can be found in the SPIRIT menu overview under Sheets / 

Presentation > Printer / Plotter: 

   

This menu can also be accessed via the pull-down menu File > Printer / Plotter. 

Value 

 Direct access to the system printer settings from the print menu. 

 Necessary adjustments can be made in the printing process. 
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Functions – Align objects 

Move, copy, rotate and stretch – all in one function. 

Description 

This new function allows you to perform several work steps at 

once. You can move objects, rotate them directly and align them to 

another object. The function can be used for all common entities 

(symbols, lines, polylines, fills, hatching, texts, etc.) in SPIRIT. 

With additional settings, the objects can also be moved and rotated 

only or, for example, can also be placed as a copy and multiple 

copy. 

Function 

In the Menu-Navigator select 2D Edit > S2 Align to start the new function. You can also select the 

additional options S1 With resize, S2 And copy as well as S3 Multiple copies. The standard selection 

in SPIRIT F1 Entity, F2 Group and F3 Area allows you to select one or more objects to be aligned. 

Now define the starting points and the corresponding target point. To rotate the object, define a 

second target point. Depending on the additionally set options, the object will also be resized based 

on the two defined target points. You can also copy the “final result” one or more times. 

Value 

 Several work steps are combined in the Align function. 

 Moving, rotating and stretching over two reference points simplifies operation. 

 The function can be used flexibly thanks to various additional functions. 
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Functions – Arrange objects  

All the way forward or all the way back – change the order of drawing for 

overlapping objects per layer. 

Description 

The order of drawing for objects is fundamentally influenced by the arrangement of the layers. SPIRIT 

offers the setting options for this under Drawing / System > F4 Layer Order > F1 to F3. The standard 

setting in SPIRIT is F3 In Order. 

But not all objects will always be drawn separately on different layers. For example, differently 

colored areas and labels must be drawn on one layer. The new functions allow you to specifically edit 

the order of drawing for the objects. 

 

 

Function 

The new Draw order function allows you to control overlapping objects on a slide that cover an area. 

For example objects such as lines, polylines, hatching and fillings, labels and pictures. The four new 

functions, which are called Draw order, offer you the following possibilities: 

 

The Draw order function can be found in the Menu-Navigator 2D Edit > Move > S3 Draw order. To 

change the order of the objects, first select the desired function and then select the desired objects 

using the standard selection functions. You must also select a reference object for the element 

forward and element back options. In addition, the context menus of the objects line, polyline, text, 

text block, dimensioning contain the option Draw order when selection has already been made. 
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Patterns in groups 

The function of the groups will be considered when arranging the objects. If objects that belong to a 

group are selected, changing the drawing order will always affect the entire group. Optionally, 

groups can be exploded, this setting is selected by default, so that only the selected object(s) will be 

arranged accordingly. 

Example for a possible arrangement of the drawing order on a layer 

These functions allow you to choose which object should be displayed in front of or behind other 

objects. You can also specify the drawing order of different object types. 

 

Note 

The drawing order of overlapping objects can only be controlled within a layer and works only if the 

corresponding layer is active. 

Value 

 Objects can now be specifically changed in their order in the drawing area. 

 Expanding the functions and objects gives you a more flexible way of working. 

 The layout with the help of fillings, hatching and text etc. is simplified. 

 

 

Polyline with filling Polyline with filling 

Dimension 

Reference 

Polyline 

with 

hatching 

Text 

Text 

Line 
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Functions – Align hatching 

The hatching fitted in perfectly. 

Description 

With this new function, you can fit hatchings better and faster into the given area. For example, you 

are now able to align the hatching of a tiled area directly in the drawing area with just a few clicks of 

the mouse. So you determined the origin, the rotation angle and the offset in a function, directly on 

the polyline. 

Function 

In the menu overview under Drafting > F1 Polyline> F6 Edit > S8 Align Hatching you get to the new 

function. Or align hatching directly via the context menu of the polyline. 

After you have defined the origin, rotation and offset, you can select the hatchings you want. This 

does not apply if you are working directly via the context menu, as the hatching (polyline) has already 

been selected. 

Value 

 Hatchings for tile grids or masonry can easily be adjusted. 

 The adjustments are made with the mouse. 

 Time-consuming correction of origin and angle in the object inspector is no longer necessary. 
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Functions – Deactivate magnet cursor for 

short time 

Now temporarily deactivate snapping yes / no 

Description 

The magnetic cursor is an important drawing tool and has been continuously optimized in the last 

version. In everyday work it happens that the magnetic cursor is not needed for just one click. 

Therefore, with SPIRIT 2021 it is possible to temporarily switch off the magnetic cursor. With the help 

of the pressed [Shift] key, the magnetic catch can be briefly interrupted. 

Function 

Snapping to snap points is temporarily switched off by pressing and holding the [Shift] key. This 

means that the cursor can be moved along an auxiliary line even if the snap point next point is not 

activated. 

Value 

 Temporary deactivation of the magnetic cursor. 

 No adjustment of the snap settings necessary. 

 Alternative to switching the magnetic cursor on and off using the shortcut key. 
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Functions – The smallest dimension becomes 

the thickness of the polyslab 

Simplified entry of panels with the correct thickness 

Description 

The thickness of a polyslab is defined via the corresponding option under 3D modeling > Polyslab > 

Thickness. Alternatively, the thickness of a polyslab can be determined indirectly via the current 

values of base and height. 

Usually the thickness corresponds to the smallest value from length, width and height. This is not 

always the case with the input types available. Therefore, a new option has been added to ensure 

this with rectangular polyslabs. 

Function 

 

When creating a polyslab, the slab thickness can be taken from different 

parameters. As a rule, however, the smallest dimension of the slab should 

be used as the slab thickness.  

With SPIRIT 2021, the additional option Modeling > Polyslab > Smallest 

Thickness can be activated. With the function, the smallest value from 

length, width and height is automatically used as the slab thickness when 

drawing a rectangular polyslab. The new floor space of the slab may then 

no longer be the construction area of the slab. 

 

 

 

Value 

 Vertical and horizontal polyslabs can be created more quickly in the floor plan. 

 The thickness always corresponds to the smallest value from length, width and height. 

 The slab thickness can be adjusted later using the object inspector. 


